
Gold Coast Chronic 
Condition Management
Continuous Quality Improvement Toolkit

The Chronic Conditions Management (CCM) QI Toolkit provides a practical 
guide to help general practices implement continuous Quality Improvement 
(QI) activities for managing chronic conditions.

It supports primary care teams in delivering structured, proactive, and 
person-centred care - enhancing continuity, improving patient outcomes, and 
increasing efficiency. The toolkit aligns with the revised CCM MBS items and the 
Strengthening Medicare reforms.
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section of 
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scroll through.
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Use the Model for Improvement and Plan-Do-Study-Act (PDSA) cycles, to 
test changes, drive progress, and embed high-quality chronic condition care 

aligned with MyMedicare and upcoming MBS reforms.
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Introduction
From 1 July 2025, the most significant reforms to 
chronic disease management in over 20 years

Major changes to the MBS framework for 
chronic disease management in primary care will 
come into effect. These changes implement the 
recommendations of the MBS Review Taskforce.

Chronic conditions affect
61% of Australians

 15.4 million people, including nearly all 
aged 85+. As demand for connected, 
multidisciplinary care grows, chronic 

conditions are driving major pressure on 
individuals and the health system. 

Key changes 
•	 A single GP Chronic Condition Management Plan (GPCCMP) replaces GPMP and TCA.
•	 All previous items (721, 723, 732, 92024–92028, etc.) have ceased and replaced.
•	 Equalised fees for preparation and review of plans ($156.55 for GPs)

Other changes
•	 Patients with at least one chronic or terminal 

condition will be eligible.
•	 Practice Nurses, Aboriginal and Torres Strait 

Islander Health Practitioners, and Aboriginal 
Health Workers can now assist in preparing or 
reviewing a plan.

•	 A plan can be prepared once every 12 months, 
and reviews can occur every 3 months. A new 
plan each year is not required—existing plans 
can be reviewed.

•	 Domiciliary medication management reviews 
will require a new-style management plan from 
1 July 2027.

•	 Multidisciplinary care plan items (e.g., for aged 
care) remain unchanged.

•	 Current plans remain valid during a 2-year 
transition period until 30 June 2027.

MyMedicare
•	 Patients registered with MyMedicare must 

have plans and reviews provided by their 
registered practice.

•	 Unregistered patients can continue to access 
plans and reviews through their usual GP.

Referring to Allied Health
•	 No need for two collaborating providers to  

initiate plan anymore—this requirement has 
been removed. 

•	  Referral letters will replace existing allied 
health referral forms.

•	 Patients must have had a plan prepared or 
reviewed within the last 18 months to access 
MBS-funded allied health services.

MBS CHANGE
ITEM & FEE

Service GP Item Number Fee Replacing

Prepare plan - face-to-face 965 $156.55 721 and 723

Prepare plan - video 92029 $156.55 92024 and 92025

Review plan - face-to-face 967 $156.55 732

Review plan - video 92030 $156.55 92028

Refer MBS guide for the frequently used items including 
Care Planning and incentives. This guide links item number to

MBS criteria, descriptor and fact sheets.

https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Upcoming%20changes%20to%20the%20MBS%20Chronic%20Disease%20Management%20Framework
https://www.health.gov.au/our-work/mbs-review?language=en
https://gcphn.org.au/wp-content/uploads/2025/11/GCPHN-MBS-Quick-Guide-1-November-2025-FINAL.pdf


Tools and Enablers
At GCPHN, we are investing in the best tools and enablers to help health professionals drive CQI. For user 
access, contact us practicesupport@gcphn.com.au or call 07 5612 5408.
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Primary Sense Primary Sense supports extracting, analysing, and managing general practice data 
in a confidential and safe way, providing ‘real time’ reports and medication alerts.

HealthPathways Developed by local GPs, specialists, nurses and allied health providers, Gold Coast 
HealthPathways supports health professionals by providing local, relevant
information on managing medical conditions and referral options for their 
patients.
A login is required.

Smart Referrals General practitioners using GP Smart Referrals can request non-urgent clinical 
advice from specialists and receive a response within 5 business days. This 
service is only available for patients within the Gold Coast Hospital and Health 
Service catchment.

Heart Foundation
Walking Groups

The Heart Foundation Walking Groups are free and are effective in encouraging
people to increase their physical activity which can help prevent and manage
diabetes, cardiovascular, mental health and their weight. 
Join a walking group and make every step matter.

GP Support 
Tools

General practitioners using GP Smart Referrals can request non-urgent clinical 
advice from specialists and receive a response within 5 business days. This 
service is only available for patients within the Gold Coast Hospital and Health 
Service catchment.

Mental Health 
Funded Services

Gold Coast Primary Health Network commissions a range of primary care and 
mental health, alcohol and other drugs and suicide prevention services to meet 
the diverse and growing needs of the Gold Coast region. Our commissioned 
services are available at no cost to patients. Alternatively, Initial Assessment and 
Referral (IAR) levels support easy referral pathways.

Gold Coast 
Hospital and 

Health Service 
– GP Advice 

Line

For services not yet available via the Request for Advice functionality in GP Smart 
Referrals, or if GP Smart Referrals is not accessible at your practice, general 
practitioners can request non-urgent clinical advice from the GP Liaison Unit’s GP 
Advice Line. Contact via: Phone 1300‑004‑242 (option 3) or
email GCGPLU@health.qld.gov.au. Please ensure you de‑identify patient 
information if sending by email. Only provide the initials of your patient’s name 
and date of birth. Available Monday to Friday, 8am to 4pm.

mailto:practicesupport%40gcphn.com.au?subject=
https://gcphn.org.au/practice-support/primary-sense/primary-sense/
mailto:https://gcphn.org.au/practice-support/primary-sense/primary-sense/?subject=
https://goldcoast.communityhealthpathways.org/LoginFiles/Logon.aspx?ReturnUrl=%2f
https://goldcoast.communityhealthpathways.org/LoginFiles/Logon.aspx?ReturnUrl=%2f
https://goldcoast.communityhealthpathways.org/LoginFiles/Logon.aspx?ReturnUrl=%2f
https://www.health.qld.gov.au/clinical-practice/innovation/smart-referrals/resources
https://goldcoast.communityhealthpathways.org/479252.htm
https://walking.heartfoundation.org.au/walking
https://walking.heartfoundation.org.au/walking
https://walking.heartfoundation.org.au/walking
https://goldcoast.communityhealthpathways.org/479252.htm
https://goldcoast.communityhealthpathways.org/1097735.htm
https://goldcoast.communityhealthpathways.org/1097735.htm
https://gcphn.org.au/about/commissioning/gcphn-funded-services/mental-health-funded-services/
https://gcphn.org.au/patient-care/mental-health/iar-dst/
https://gcphn.org.au/patient-care/mental-health/iar-dst/
https://goldcoast.communityhealthpathways.org/479252.htm
https://goldcoast.communityhealthpathways.org/479252.htm
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Activity Navigation 
1.1 Practice Readiness Checklist
1.2 Preparing for CCM QI in action
1.3 Communication Action Plan
1.4 Practice Change (QI) Plan
1.5 Practice Meeting template

Module 1
Leadership - Preparing your practice

On completion of this module, you will:
•	 Evaluate your practice’s readiness to implement  

MyMedicare and Chronic Condition Management
•	 Engage the entire practice leadership team to confirm 

MyMedicare registration status and ensure readiness 
for the transition
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MyMedicare and Chronic Conditions Management (CCM) 
Foundations

MyMedicare is a Voluntary Patient Registration (VPR) model that connects patients with their preferred 
general practice and care team to promote continuity and comprehensive care.

By choosing a MyMedicare practice, patients formalise where GPCCMP MBS items can be accessed. This
connection strengthens relationships and ensures proactive care planning for long-term conditions.

Eligible Patients registered with MyMedicare can only access GP Chronic Condition 
Management Plan services (face-to-face or telehealth) at their MyMedicare registered 

practice location, delivered by any eligible provider (including GP registrars) there, 
not other practices or locations.

Chronic Conditions MBS items support primary care providers to develop plans and continue to actively 
manage, monitor, and coordinate ongoing care with other providers working as a multidisciplinary team, 
for patients diagnosed with a chronic condition that is expected to impact their health for longer than 6 
months.

GPCCMP items also support access to allied health and other services for patients that would benefit from
multidisciplinary team care to manage their chronic condition.

For more information, refer to the Services Australia Fact Sheet – Overview of MBS Changes

MyMedicare Practice 
Registration

•	 Link your organisation in PRODA to HPOS
•	 Access the Organisation Register in HPOS 

to register your practice and link your 
eligible health care providers

•	 Add MyMedicare to ‘My Programs’ in HPOS
•	 Ensure practice staff have appropriate 

delegations to access MyMedicare on HPOS

Learn more:
•	 Service Australia’s MyMedicare

Practice Resources

•	 CDM Changes – Overview
•	 CDM Changes – Transition Arrangements
•	 CDM Changes – Referral Arrangements
•	 CDM Changes – GPCCMP MBS Items
•	 CDM Changes – Allied Health Providers
•	 CDM Changes – Practice nurse, Aboriginal
•	 Health workers and ATSI Health 

Practitioners
•	 MyMedicare - Service Australia e-learning
•	 RACGP summary of CCM changes
•	 MyMedicare - Translated resources
•	 MyMedicare - GP Communication Toolkit
•	 MyMedicare - Practices and providers
•	 Chronic Condition Management Items 

Gold Coast Health Pathways 
•	 RACGP - Chronic disease
•	 RACGP – Preventive Activities (the Red 

Book)

https://www.health.gov.au/our-work/mymedicare/about
https://www.health.gov.au/our-work/mymedicare/patients#eligibility
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
https://www.health.gov.au/our-work/upcoming-changes-to-mbs-chronic-disease-management-arrangements
https://www.mbsonline.gov.au/
https://www.servicesaustralia.gov.au/proda-provider-digital-access
https://www.servicesaustralia.gov.au/hpos?context=20
https://www.servicesaustralia.gov.au/register-organisation-register-hpos?context=20
https://www.servicesaustralia.gov.au/hpos?context=20
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20-%20Overview.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF Version - Upcoming Changes to Chronic Disease Management MBS Items – Transition Arrangements for Existing Patients.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF Version - Upcoming Changes to Chronic Disease Management Framework – Referral Arrangements for Allied Health Services.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20-%20GPCCMPs.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20framework%20-%20Allied%20Health%20Providers.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20frame~%20and%20Aboriginal%20and%20Torres%20Strait%20Islander%20health%20practitioners%20and%20workers.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20frame~%20and%20Aboriginal%20and%20Torres%20Strait%20Islander%20health%20practitioners%20and%20workers.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20frame~%20and%20Aboriginal%20and%20Torres%20Strait%20Islander%20health%20practitioners%20and%20workers.pdf
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://www.racgp.org.au/advocacy/advocacy-resources/summary-of-changes-to-chronic-disease-management
https://www.health.gov.au/our-work/mymedicare/resources
https://www.health.gov.au/resources/publications/mymedicare-gp-toolkit?language=en
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
https://goldcoast.communityhealthpathways.org/76752.htm
https://goldcoast.communityhealthpathways.org/76752.htm
https://www.racgp.org.au/clinical-resources/clinical-guidelines/guidelines-by-topic/view-all-guidelines-by-topic/chronic-disease
https://www.racgp.org.au/clinical-resources/clinical-guidelines/key-racgp-guidelines/view-all-racgp-guidelines/preventive-activities-in-general-practice/about-the-red-book
https://www.racgp.org.au/clinical-resources/clinical-guidelines/key-racgp-guidelines/view-all-racgp-guidelines/preventive-activities-in-general-practice/about-the-red-book
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1.1 Pre-Activity – Practice Readiness Checklist

Before commencing your activity, evaluate your practice’s readiness to implement MyMedicare and 
CCM. Engage your leadership team to confirm registration status and ensure a smooth transition.

Step 1 Actions Assigned to

Plan the
transition

Nominate a CCM change lead and team

Document the change plan, timeline, patient registers, and 
team responsibilities
Need help? Contact your Gold Coast PHC Engagement Officer

Meet with the team, define team roles, responsibilities, and 
timelines

Conduct data cleansing and archive inactive records

Set up a shared folder for documentation (e.g. Teams/Google 
Drive)

Coordinate audits and maintain up-to-date patient registers 
(Use GCPHN Data Cleansing Toolkit)

Schedule regular team meetings to track progress

Step 2 Actions Assigned to

System &
Resource
Setup

Register practice and providers in PRODA

Assign team in PRODA 
organisation account 
delegations and
permissions

Add MyMedicare to ‘My Programs’ in HPOS

Update workflows, templates, and policies (if needed)

Allocate team time for updates and training

Audit existing CDM resources and store centrally for ease of 
access

Step 3 Actions Assigned to

Prepare
your team

Train the team in MyMedicare benefits, registration and CCM 
changes

Define roles and workflows (use the Swim Lane template)

Allocate protected time for each team member’s transition role

Provide regular updates to the team via internal 
communication

Refer clinicians to HealthPathways for the latest guidelines 
and referral pathways

Brief Allied Health providers on upcoming changes (refer to 
Referral Arrangements for Allied Health Services)

https://gcphn.org.au/wp-content/uploads/2025/08/Meet-your-GCPHN-Engagement-Officers.pdf
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/data-quality/
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/data-quality/
https://www.servicesaustralia.gov.au/how-to-register-for-individual-proda-account?context=33786
https://www.servicesaustralia.gov.au/managing-members-and-delegations-organisation-proda?context=33786
https://www.servicesaustralia.gov.au/managing-members-and-delegations-organisation-proda?context=33786
https://www.servicesaustralia.gov.au/hpos
https://gcphn.org.au/practice-support/mymedicare/mymedicare/#patients-benefits
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Upcoming%20changes%20to%20the%20MBS%20Chronic%20Disease%20Management%20Framework
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Upcoming%20changes%20to%20the%20MBS%20Chronic%20Disease%20Management%20Framework
https://goldcoast.communityhealthpathways.org/
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF Version - Upcoming Changes to Chronic Disease Management Framework – Referral Arrangements for Allied Health Services.PDF
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Step 4 Actions Assigned to

Patient
Engagement
&
Registration

Use MyMedicare Communication kit (brochures, posters, 
videos, website & social media)

Ensure reception staff register patients opportunistically and 
invite others (SMS, email, or in-person)

Communicate the shift from CDM to CCM to patients

Assist patients with form completion or digital registration

Confirm who will add/invite patients to MyMedicare via 
PRODA. Make sure to enable ‘Auto Accept’ for registrations in 
MyMedicare Preferences via PRODA.

Regularly import registered patient lists into your CMS refer to 
guides

Monitor de-registrations via HPOS – refer activity Management 
registration via HPOS

Best Practice Medical Director Cubiko

Step 5 Actions Assigned to

Patient
Identification
& Recall

Use Primary Sense Patients with High Complexity 5 & 4 Report 
to identify eligible patients.

Offer GPCCMP plans opportunistically (during consults, HA’s, 
immunisations)

Recall existing CDM patients to update them to GPCCMP

Support clinicians with referrals, scripts, and bookings

Set automated reminders (BP/MD, Hotdoc, AutoMed, 
Healthengine)

Establish / review your process for booking reviews & 
managing missed appointments

Step 6 Actions Assigned to

Monitor,
Reflect, and
Celebrate

Use QI tools to track CCM transition activities (e.g., PDSAs, 
data reviews)

Monitor registration targets and plan review timelines

Regularly review and update all documentation

Review your video telehealth setup for MyMedicare (consider 
using -create a Healthdirect account or login)

Celebrate milestones and successes with your team

Adapted from: Brisbane North PHN and West Vic PHN

https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.emphn.org.au/images/uploads/files/PRODA-Guide-Updating-MyMedicare-Preferences-to-enable-Auto-Accept-of-patient-led-registrations.pdf
https://kb.bpsoftware.net/bppremier/Spectra/Integrations/MyMedHPOSCSVImport.htm
https://www.medicaldirector.com/news/practice-management/mymedicare-administration-in-medicaldirector-your-essential-guide/
https://wentwest.com.au/wp-content/uploads/2025/05/Medical-Director-identify-and-flagging-patient-for-mymedicare.pdf
https://www.cubiko.com.au/gpccmp
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/
https://www.healthdirect.gov.au/video-call-reg
https://vcc.healthdirect.org.au/login


CCM Toolkit - © Gold Coast Primary Health Network Page 10 
Printed copies of this document are uncontrolled. Version 2. 4 September 2025

The infographic below depicts an example of management planning for a chronic condition patient. Review
appointments as clinically relevant support ongoing patient engagement and care continuity.

Do a PDSA - Team
awareness, desire

and readiness

CALL TO 
ACTION
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1.2 Activity - Preparing your practice for CCM QI Action

A systematic approach to defining team roles, engaging patients, and quality improvement is necessary 
for successful Chronic Condition Management (CCM).

Every successful Quality Improvement starts with setting clear goals, underpinned by data and requires 
ongoing measurement and cycles of new activity in response to your findings. This process engages your 
primary health care team in assessing progress and tracking if change(s) are leading to an improvement.

Demonstrating the impact of your team’s QI actions is essential to maintaining engagement, momentum 
and building a culture of celebrating success!

It is best to measure at the beginning of the activity (baseline) and then at regular intervals. Use the Model 
for Improvement (MFI) framework to methodically work through identifying a clear problem, and to 
explore solutions and take action.

The QI Activity Goal below is an example of a clear goal for Chronic Conditions Management and 
MyMedicare you could adapt to your practice.

https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/getting-started/
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/getting-started/
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1.3 Activity – Communication Action Plan

QI focus area
Why improve

this focus area?
QI ideas

“What” of the action plan Resources

MyMedicare
Patient
Registration

To increase patient
registration for 
MyMedicare for our 
General Practice

What are the benefits of
undertaking activities in this 
area?

•	 Opportunity to formalise, 
establish or enhance our 
relationship for ongoing 
coordinated care with patients

•	 To prepare for Chronic 
Conditions Management 
(CCM) MBS item changes

•	 To prepare for changes to 
Better Access Mental Health 
Treatment Plans

What ideas can we explore?

Tips for engaging patients:
•	 Encourage registration as they present to the 

practice or attend appointments including 
patient who have:
•	 attended the practice twice in 24 months
•	 attend the practice for ongoing care 

management (e.g. Chronic Disease 
Management Plans, Mental Health 
Treatment Plans, Health Assessments and 
Health Checks)

Communication approaches/ideas
•	 Posters or flyers - waiting room and reception
•	 Website and/or social media
•	 Targeted identification - Search and tag patient 

records for action when they present or contact 
the practice

•	 Encourage patients to register through 
Medicare Online Account

•	 Conversations at appointments including 
reminder cards, information in clinic rooms.

•	 SMS or email campaign
•	 MyMedicare patient forms offered to patients 

(notepaper forms submitted through PRODA 
require additional staff time required to 
process)

•	 Poster documenting your unique MyMedicare 
value or key messages

Clinic resources

1.	 MyMedicare GP Toolkit 
(includes posters, social tiles, 
flyers, etc)

2.	 MyMedicare Videos
3.	 Introducing MyMedicare – 

Fact sheet
4.	 Registering in MyMedicare – 

Fact sheet
5.	 MyMedicare practice 

registration – Frequently 
asked questions

6.	 Registering patients with 
MyMedicare – Systems 
overview for practices and 
providers

7.	 MyMedicare Program  
Guidelines

8.	 About MyMedicare for health 
professionals

Practice name:

https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers?language=en#brochures-and-posters
https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers?language=en#gp-and-community-stakeholder-kit
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.health.gov.au/resources/publications/mymedicare-gp-toolkit?language=en
https://www.bing.com/videos/riverview/relatedvideo?&q=Mymedicare+eligibility&qpvt=Mymedicare+eligibility&mid=382C1030412A4D4645B3382C1030412A4D4645B3&mmscn=mtsc&aps=3&FORM=VRDGAR
https://www.health.gov.au/resources/publications/introducing-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/introducing-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/registering-in-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/registering-in-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/mymedicare-practice-registration-frequently-asked-questions?language=en
https://www.health.gov.au/resources/publications/mymedicare-practice-registration-frequently-asked-questions?language=en
https://www.health.gov.au/resources/publications/mymedicare-practice-registration-frequently-asked-questions?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/publications/mymedicare-program-guidelines?language=en
https://www.health.gov.au/resources/publications/mymedicare-program-guidelines?language=en
https://www.servicesaustralia.gov.au/about-mymedicare-for-health-professionals?context=20#:~:text=To be eligible for MyMedicare, providers must: 1,or Department of Veterans’ Affairs (DVA) equivalent services.
https://www.servicesaustralia.gov.au/about-mymedicare-for-health-professionals?context=20#:~:text=To be eligible for MyMedicare, providers must: 1,or Department of Veterans’ Affairs (DVA) equivalent services.
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1.4 Activity – Practice Change (QI) Plan

Please complete the following table to outline your plan to complete the goal.

En
ga

ge
d

Le
ad

er
sh

ip

Goal Improve chronic condition management by focusing on MyMedicare registration in [insert time frame] from ##% (## patients) to ##% (## patients) 
by DD/MM/YYYY.

Measure/s

•	 number of patients MyMedicare registered
•	 number of patients on the chronic conditions register
•	 number of management plans/reviews billed
•	 number of appointments (missed, rebooked)

Search criteria

QI Lead and Team Who will need to be involved? Period Start date - end date

R
efl

ec
ti

on

Outcomes
Summary

As a team, what did you learn? What changes would you make to your practice as a result?

RACGP CPD Tip: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection.

Actions Tip: Use PDSA cycles to test change ideas Activity Resources Who Period Update

D
at

a-
D

ri
ve

n
Im

pr
ov

em
en

t Conduct data cleansing to identify and verify patients with MyMedicare status and chronic 
conditions.

•	 Data Cleansing 
Toolkit

Start date -
end date

Allocated a usual care 
provider to patients

Identify your MyMedicare and CCM patients using Primary Sense and document baseline data •	 Primary Sense

Find eligible patients that are due for management plan/ review •	 Primary Sense

Pa
ti

en
t

R
eg

is
tr

at
io

n Ensure recall and reminder system is established for MyMedicare and CCM patients •	 BP Reminder
•	 MD Recalls

Educate patients on CCM management plan and review benefits

Communicate and promote MyMedicare and CCM

Te
am

-B
as

ed
C

ar
e

Identify roles and responsibilities

Map workflows and upskill team in MyMedicare and CCM

Assign a nurse or admin staff to track and rebook missed appointment

Train clinical staff to enter coded diagnoses (no free text)

Ensure staff can access HealthPathways for the latest chronic conditions assessment, management 

and referral information
•	 Gold Coast 

HealthPathways

Create patient-centred goals with more frequent reviews

https://mycpd.racgp.org.au/log
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/data-quality/
https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/data-quality/
https://gcphn.org.au/practice-support/primary-sense/primary-sense/
https://gcphn.org.au/practice-support/primary-sense/primary-sense/
https://kb.bestpracticesoftware.com/bppremier/spectra/Clinical/Reminders/ClinicalReminders.htm
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FAdding_and_Editing_Recalls.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://goldcoast.communityhealthpathways.org/
https://goldcoast.communityhealthpathways.org/
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1.5 Activity – Practice Meeting template

The most common way for practices to build teamwork is to schedule regular meetings where all members 
of the practice team are encouraged to contribute to discussions. It is a good idea to keep minutes of the 
meetings and to document the decisions made at team meetings and the names of those responsible for
implementing related actions.

A Practice Meeting needs between 2-25 participants (GPs, practice staff and other health professionals) 
with each meeting lasting at least 30mins, in order to meet CPD activity requirements.

< Practice Meeting Title>
Please note:
•	 (C0.0  C, QI0.0A) is RACGP Standards for General Practices – 5th edition indicator
•	 RACGP CPD type: Educational Activities (EA), Reviewing Performance (RP), Measuring Outcomes (MO)

PRACTICE Date:

CHAIR

(GP/Practice Lead)
Time:

Participant names

Agenda/ Topics Actions/ Summary – Example CPD Type / Duration

1. Quality
Improvement
(QI1.1   B,C,D)

•	 This can include updates on QI projects such as MyMedicare, Chronic Condition Management 

(CCM) change ideas, coming together to discuss changing current processes to improve data, staff 

feedback on anything relating to the practice.

•	 Making quality improvements to the practice’s structures, systems and clinical care that are based 

on the practice’s information and data will lead to improvements in patient safety and care.

Quality Improvement includes:

•	 Patient health records quality

•	 MyMedicare/CCM project changes to the day-to-day operations of the practice, such as – scheduling 

of appointments – normal opening hours – record-keeping practices – how patient complaints are 

handled – systems and processes

•	 Responding to feedback or complaints from patients, carers or other relevant parties

•	 Responding to feedback from members of the practice team

•	 Auditing clinical databases

•	 Analysing near misses and errors

•	 Practices –what QI is being implemented across the practice

MyMedicare Practice Registration:

•	 MyMedicare practice registration checklist here.

•	 Adding GPs as providers to the Organisation Register in PRODA here.

•	 Providing practice staff with relevant delegations to view and manage patient registration here.

•	 Educating non-clinical staff on the steps involved in patient registration with your practice and 

preferred GP here.

MyMedicare Patient Registration:

•	 Patient facing resources to formalise the relationship between patient, general practice, and pre-

ferred GP here.

•	 Patient eligibility and methods of registration here.

•	 MyMedicare Patient Registration Form here.

MyMedicare and CCM Examples meeting resources:

•	 Patient registration benefits here.

•	 MyMedicare General Practice Communication Toolkit here.

•	 CCM MBS item changes – Overview here.

RP 30mins

https://www.racgp.org.au/running-a-practice/practice-standards/standards-5th-edition/standards-for-general-practices-5th-ed/introduction-to-the-standards-for-general-practice/accreditation
https://hpe.servicesaustralia.gov.au/INFO/MYMED/MYMEDINFO1.pdf
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers
https://www.health.gov.au/our-work/mymedicare/patients#how-to-register
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://wentwest.com.au/health-professionals/programs-and-priorities/digital-health/mymedicare/#:~:text=There%20are%20several%20benefits%20of,and%20D)%20for%20registered%20patients
https://www.health.gov.au/resources/publications/mymedicare-community-information-kit?language=en
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520-%2520Overview.DOCX&wdOrigin=BROWSELINK


CCM Toolkit - © Gold Coast Primary Health Network Page 15 
Printed copies of this document are uncontrolled. Version 2. 4 September 2025

•	 CCM MBS item changes – Transition Arrangements for Existing Patients here.

•	 CCM MBS item changes – Referral Arrangements for Allied Health Services here.

•	 CCM MBS item changes – MBS Items for GP Chronic Condition Management Plans here.

RP 30mins

2. Risk
management
including
Clinical Risk
(C3.1    C, QI3.1A)

Have any staff identified any risks in the practice that should be addressed? If
mentioned here, they should be placed in the risk register and addressed.
Examples:

•	 Poor record keeping

•	 IT system failures

•	 Inadequate systems for updating patients’ contact details and following up test results

•	 Workplace health and safety incidents, as a result of equipment that is not maintained in accordance 

with the manufacturer’s recommendations

•	 Inadequate number of practice staff working during busy times

•	 Conflicts of interest/ethical dilemmas

•	 Updates to or breaches of the IT security system.

3. Patient
Feedback
(QI1.2    B)

Depending if the practice collects feedback once every three years or on a
continual basis will guide this agenda item. Either way this is a good time to
address patient feedback and possibly ask the team if they have any solutions.

4. WHS
(C3.5    A)

Raising issues about the health and safety of the team. For example, are duress
alarms required, how to deal with an aggressive patient.

5. Clinical Care of
patient’s
(C5.1    A,B)

•	 When clinical teams discuss clinical care, they must refer to and consider the best available 

evidence, to ensure their clinical care aligns with best practice. In some instances, ‘best practice’ 

may involve doing more than adhering to current clinical guidelines. Each team meeting there could 

be a new clinical topic, such as referral for a colonoscopy where patient symptomatic and urgency of 

referral are discussed

•	 Specific patient cases can also be discussed at team meetings if patient confidentiality is 

maintained.

6. Other •	 Ethical dilemmas- These are then to be entered into an ethical dilemma log and the patient’s files- 

C2.1    E

•	 Administrative matters- C3.4    A

•	 Infection control updates including changes to guidelines and laws.

•	 An opportunity to announce local outbreaks and public health alerts - GP4.1    A

https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520MBS%2520Items%2520%25E2%2580%2593%2520Transition%2520Arrangements%2520for%2520Existing%2520Patients.DOCX&wdOrigin=BROWSELINK
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520%25E2%2580%2593%2520Referral%2520Arrangements%2520for%2520Allied%2520Health%2520Services.DOCX&wdOrigin=BROWSELINK
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520-%2520GPCCMPs.DOCX&wdOrigin=BROWSELINK
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Activity Navigation 
2.1 Reminders, Registration and flagging
      2.1.1 Management registration
      2.1.2 BP–Registration and flagging
      2.1.3 BP - My Health Record
      2.1.4 MD –Registration and flagging
      2.1.5 MD- My Health Record
2.2 Staff Scripts
2.3 How to check your MyMedicare registration

Module 2
Patient Registration & Engagement

On completion of this module, you will:
•	 Enhance communication strategies to boost patient 

participation in MyMedicare and CCM.
•	 Develop effective systems for timely care plan review 

reminder
•	 Design resources that educate and encourage active 

involvement in care planning and review
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Person-centred care is the foundation of both CCM and MyMedicare

At the heart of both MyMedicare and Chronic Conditions Management (CCM) is person centred care —
healthcare that aligns with each patient’s unique values, needs, and life goals. This approach strengthens 
engagement, supports continuity, and leads to better health outcomes. Core principles include:

1.	 Dignity
2.	 Compassion
3.	 Coordinated
4.	 Personalised Care
5.	 Empowerment for Self-Management

Both initiatives promote active patient participation and shared decision-making, moving away from one-
size-fits-all models to deliver care that is truly tailored to the individual.

This often begins by asking “What matters to you?” 
rather than “What is the matter with you?” to better 

understand and incorporate the patient’s life 
goals into care planning. It fosters greater patient 

engagement in the care planning process and 
supports tailored, meaningful care.

MyMedicare Practice 
Registration

1.	 Medicare online - MyGov Account
2.	 Paper registration form, submitted in 

person at our practice. You can pre-fill 
MyMedicare forms - Refer to Activity

Tip: Enable ‘Auto Accept’ for patient 
registrations in MyMedicare Preferences via 
PRODA and pre-fill

Learn more:
•	 Managing MyMedicare registrations – 

eLearning
•	 Our MyMedicare Patient Registration 

Guide
•	 Our MyMedicare One Page Patient Guide

Practice Resources

•	 MyMedicare - DL Brochure
•	 MyMedicare - Easy Read Brochure
•	 MyMedicare - Poster 1
•	 MyMedicare - Poster 2
•	 MyMedicare - Poster First Nations
•	 MyMedicare - Community Information kit
•	 Introducing MyMedicare Video
•	 Registering in MyMedicare Video
•	 MyMedicare - Social Media Tile

https://www.health.gov.au/our-work/mymedicare/about
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.emphn.org.au/images/uploads/files/PRODA-Guide-Updating-MyMedicare-Preferences-to-enable-Auto-Accept-of-patient-led-registrations.pdf
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://wentwest.com.au/wp-content/uploads/2023/11/MyMedicare-Patient-Registration-Guide.pdf
https://wentwest.com.au/wp-content/uploads/2023/11/MyMedicare-Patient-Registration-Guide.pdf
https://wentwest.com.au/wp-content/uploads/MyMedicare/6.-WW-MyMedicare-Patient-Registration-One-Pager.pdf
https://www.health.gov.au/sites/default/files/2023-09/mymedicare-dl-brochure.pdf
https://www.health.gov.au/resources/publications/mymedicare-what-it-is-and-how-to-sign-up-easy-read?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-1?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-2?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-first-nations?language=en
https://www.health.gov.au/resources/publications/mymedicare-community-information-kit?language=en
https://www.health.gov.au/resources/videos/introducing-mymedicare?language=en
https://www.health.gov.au/resources/videos/registering-in-mymedicare?language=en
https://www.health.gov.au/resources/publications/mymedicare-social-tiles?language=en
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2.1 Activity – Reminders, Registration and Flagging

This activity helps practices implement or enhance reminder and recall systems to
improve MyMedicare registration, support care planning, and ensure timely reviews for patients with 
chronic conditions. By leveraging your clinical software, you can:

•	 Proactively identify and flag eligible patients
•	 Pre-fill MyMedicare registration forms (RTF) for 

individual patients or bulk print them using mail 
merge

•	 Automate communication and reminders
•	 Improve data accuracy and patient engagement

This enables smoother registration, better continuity of care, and future-ready MBS claiming.

The following steps and screenshots show how to register and flag patients in Best Practice, Medical 
Director, and My Health Record.

Software-Based Instructions

Patients can then register
using these pre-filled
paper forms or via the

Medicare Online Account

Best Practice (BP)

BP Spectra will compass all CCM changes 
including database searches, printable 
guides and desktop foldout resources.
•	 Use MyMedicare Awareness and BP 

Comms to reach eligible patients
•	 Use BP database queries to identify 

eligible patients
•	 Tools:

•	 Reminder
•	 Actions
•	 Mail merge
•	 SMS reminders

BP MyMedicare | bpsoftware.net
1300 40 1111

Medical Director (MD) and Pracsoft

•	 Use Telstra Health Smart Visual 
Dashboards to identify eligible patients, 
Track MyMedicare registrations, Send 
SMS reminders.

•	 Tools:
•	 Reminder
•	 Actions
•	 Mail merge
•	 SMS reminders

MD MyMedicare | medicaldirector.com
1300 300 161

Cubiko (for BP/MD users)

•	 GPCCMP home
•	 Cubiko Insights: GPCCMP metrics 

and forecasting dashboard
•	 Cubiko Insights: CCM Preparation: 

Actionable metrics My Dashboard
•	 Resource pack including staff room 

poster, patient handout, flyer and 
printouts

•	 Identify and flag MyMedicare eligible 
patients

•	 Export/import CSV lists for targeted 
outreach

Cubiko Knowledgebase
1300 CUBIKO

Other Reminder Systems

The following platforms can also be used
independently or in conjunction with your 
clinical software to manage patient recalls 
and reminders:

•	 Pracsoft
•	 Hotdoc
•	 Healthengine
•	 AutoMed

Note: GCPHN does not provide software licensing for these systems.

https://www.servicesaustralia.gov.au/medicare-online-account
https://kb.bestpracticesoftware.com/docs/qrg/BpPremier_QRG_GPChronicConditionManagementPlans.pdf
https://kb.bestpracticesoftware.com/docs/qrg/BpPremier_PrintableFoldout_CDMChangesJuly2025.pdf
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMBpComms.htm
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMBpComms.htm
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMPatients.htm
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMPatients.htm
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Actions.htm?Highlight=actions
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendHealthAwareness.htm?Highlight=send%20health%20awareness
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm?Highlight=Send%20clinical%20reminders
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMedicareHome.htm
https://www.bpsoftware.net/
https://www.medicaldirector.com/help/index.htm?#t=kba%2Fclinical%2FRecalls%2C_Reminders%2C_Actions%2C_and_Outstanding_Requests_-_Fact_Sheet.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FAbout_Recalls%2C_Recall_Actions_and_Outstanding_Actions.htm&rhsearch=mymedicare
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FMail_Merge.htm&rhsearch=mail%20merge&rhhlterm=mail%20merge&rhsyns=%20
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FSMS_Reminders_About_and_Registration.htm&rhsearch=SMS%20Reminders&rhhlterm=SMS%20Reminders&rhsyns=%20
https://www.medicaldirector.com/news/practice-management/mymedicare-administration-in-medicaldirector-your-essential-guide/
http://www.medicaldirector.com/
https://www.cubiko.com.au/GPCCMP/
https://www.cubiko.com.au/features/ccm/
https://app.cubiko.com.au/app/dashboards/template/632e2016-a111-4788-9fd2-08632c86061a
https://www.cubiko.com.au/resources/chronic-condition-management-resource-pack/
https://kb.cubiko.com.au/en/mymedicare-eligible-patients-with-an-appointment-today
https://kb.cubiko.com.au/en/mymedicare-eligible-patients-with-an-appointment-today
https://kb.cubiko.com.au/en/mymedicare-csv-export-import
https://kb.cubiko.com.au/en/cubiko-knowledge-base#mymedicare
https://www.medicaldirector.com/help/index.htm?#t=shared-content%2FStart_Pracsoft.htm
https://practices.hotdoc.com.au/
https://practices.healthengine.com.au/blog/heres-your-support-team-tip-reminders-plus/
https://automedsystems.com.au/automed-sms-appt-reminders-dna/
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2.1.1 Management registration via HPOS

To support your team, access the Services Australia MyMedicare eLearning modules for MyMedicare 
overview and Managing patient registration.

Accessing the Patient List in HPOS >MyMedicare program
1.	 Log in to PRODA to use HPOS → Select the organisation to act on behalf of.
2.	 Got to My Programs → MyMedicare
3.	 Go to Patient List

Viewing Withdrawn or De-registered Patients
4.	 In the Patient List, use the Search Criteria filters.
5.	 Tick “Withdrawn registrations” to include de-registered patients.
6.	 Look under the “Date Withdrawn” column to see when deregistration occurred.

Exporting Patient Records
7.	 Click Export Complete Registrations List to download both Complete and Pending lists). Use this list 

to track deregistered patients and take follow-up action

If “MyMedicare”
doesn’t appear, your
PRODA access may

need updating.

https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM01/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM01/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
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Accessing the Patient List in HPOS >MyMedicare program
1.	 Log in to PRODA to use HPOS → Select the organisation to act on behalf of.
2.	 Go to Messages → My organisation(s) mailbox.
3.	 Select Settings → Choose your email and notification frequency (immediate, daily, weekly)
4.	 Click Submit.

Here’s an example of MyMedicare Patient registration activities

Individual patient
1.	 Log in to PRODA to use HPOS → Select the organisation to act on behalf of → My Programs → 

MyMedicare
2.	 Go to Register a patient → Find a patient
3.	 Then Enter details: Medicare/DVA CARD number, IRN, First name, DOB → tick declaration → click Find
4.	 Select patient → Register for MyMedicare
5.	 Choose: Practice (Organisation site) → Preferred GP
6.	 Select Confirm eligibility (auto or select reason)
7.	 Select Review details → tick declaration → click Confirm
8.	 For pending registration: choose “Pending” instead of “Complete” on step 4.

If the patient is registered with another practice, this message will appear:

https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
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2.1.2 Best Practice – CCM, MyMedicare Registration and flagging 

For the latest updates, visit BP Premier Spectra including MyMedicare Medicare Web services (enrolment management and
registration check)new templates (GPCCMP and CCMP AHP referral), appointment types, SQL queries and Co-billing logic.

MyMedicare Registration Form via Letter writer
Letter writer (RTF format) will auto-populate with patient details ready for 
patient to provide sign consent.

File → New Letter (F4) → Templates → Use Template → Open

Flagging MyMedicare registered status
MyMedicare Registered status will be displayed on:

Individual Patient Registration
File → Open Patient → View → Patient/F2 → View details →
Complete the fields listed below → Save

Bulk import option of MyMedicare: Download exported registration list from HPOS for patient registration status and import list using BP Premier Reporting ToolCALL TO 
ACTION

https://kb.bestpracticesoftware.com/bppremier/spectra/Clinical/EPC/GPCCMP.htm
https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyMedHPOSCSVImport.htm?Highlight=bulk%20import%20mymedicare


Page 22  CCM Toolkit - © Gold Coast Primary Health Network
Printed copies of this document are uncontrolled. Version 2. 4 September 2025

2.1.3 Best Practice - My Health Record and MyMedicare Registration 

Retrieve MyMedicare Documents from My Health Record. MyMedicare information is sourced from Medicare systems operated by Services Australia and 
includes the patient’s Registration date,  Practice Name, Practice Address, and preferred GP name, if supplied.

File → Open Patient, View → Patient/F2 → My Health Record → View Document List → Filters → untick the Exclude Medicare documents and Exclude 
prescription and dispense records → Update → select MyMedicare Registered Practice information document → Open

To access My Health Record, your staff
•	 • must have an HPI-I (identifies individual 

healthcare providers) To obtained via AHPRA 
account or by calling 1300 419 495, while non- 
AHPRA staff can apply through HPOS.

•	 Set User permissions: Best Practice main screen 
> Setup > Users > select employee > Edit > 
Set Permissions > scroll to My Health Record 
Access > Select ‘Allowed’ > Save.

Please note the My Health Record participation
obligations and Security and Access policies – Rule 
42 guidance.

Save a Document to a Patient Record Please note patent preference to save this 
document  - See Understanding confidentiality and patient notes for more information.

CALL TO 
ACTION

https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyHealthRecord/MyMedicareDocRetrieval.htm
https://www.ahpra.gov.au/Registration/Registers-of-Practitioners.aspx
https://www.servicesaustralia.gov.au/registering-to-use-healthcare-identifiers-hi-service-for-individual-healthcare-providers
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Confidentiality.htm
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MyMedicare Registration Form via Letter writer
Letter writer (RTF format) will auto-populate with patient details ready for 
patient to provide sign consent.

Patient File → Tools → Letter Writer (F8) or          File → New → Ok

2.1.4 Medical Director – MyMedicare Registration and flagging

Individual Patient Registration
File → Open Patient → View details → tick “This patient is registered with this
Practice for MyMedicare” → select Preferred GP = “Regular Practitioner” → Save
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2.1.5 Medical Director - My Health Record and MyMedicare Registration

Retrieve MyMedicare Documents from My Health Record. MyMedicare information is
sourced from Medicare systems operated by Services Australia and includes the 
patient’s Registration date, Practice Name, Practice Address, and preferred GP name, 
if supplied.

Patient File → My Health Record (or view document list)

To access My Health Record, your staff
•	 • must have an HPI-I (identifies individual 

healthcare providers) To obtained via AHPRA 
account or by calling 1300 419 495, while non- 
AHPRA staff can apply through HPOS.

•	 Set User permissions: Best Practice main screen 
> Setup > Users > select employee > Edit > Set 
Permissions > scroll to My Health Record Access 
> Select ‘Allowed’ > Save.

Please note the My Health Record participation
obligations and Security and Access policies – Rule 
42 guidance.

Save a Document to a Patient Record Please note patent preference to save this 
document  - See Understanding confidentiality and patient notes for more information.

CALL TO 
ACTION

https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyHealthRecord/MyMedicareDocRetrieval.htm
https://www.ahpra.gov.au/Registration/Registers-of-Practitioners.aspx
https://www.servicesaustralia.gov.au/registering-to-use-healthcare-identifiers-hi-service-for-individual-healthcare-providers
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Confidentiality.htm
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2.2 Activity – Scripts: phone, SMS, email, and website

Please tailor scripts for phone, SMS, email, and website for staff to use when communicating with patients about Chronic Condition Management Plans 
and MyMedicare.

📞 Phone Script
(Reception or Nurse Call)

Hi, this is [Your Name] from
[Practice Name]. I’m just checking
in about your ongoing care.

If you have a health condition that
lasts six months or more, you may
be eligible for a Care Plan. This
supports your health with a clear
plan, plus up to 5 subsidised visits
per year to allied health providers
like a physio or dietitian.

We also recommend registering for
MyMedicare, which helps us
provide more coordinated care.
Would you like to book a longer
appointment to get started or get
more info?

📱 SMS Script

Hi [First Name], you may be eligible
for a Care Plan and MyMedicare
registration with your GP at
[Practice Name].

This can support your ongoing care
and give access to subsidised
allied health visits.
Call [Phone] or book online:
[Website]

📧 Email Script

Subject: Care Plan & MyMedicare 
– Supporting Your Health

Hi [First Name],
If you have a long-term health
condition, you may benefit from a
Care Plan at [Practice Name]. It
helps you and your GP plan and
manage your care, and may include
up to 5 subsidised allied health
visits per year.
We also recommend registering
with MyMedicare to make sure your
care is continuous and 
wellcoordinated.
🕑 A longer appointment is needed
to set up your plan.
📅 You’ll check in with your GP
every 3–6 months.
Reply to this email, call us on
[Phone], or book online at [Website]

🌐 Website Text
(Info Page or Pop-up)

Do you have a long-term health
condition?

We can help you manage it with a
Care Plan at [Practice Name]. This
includes:
o Your health goals
o How we’ll support you
o Up to 5 Medicare-subsidised
visits to allied health providers

We also recommend registering for
MyMedicare, a free program that
links you to us as your regular
practice — for more coordinated
care.
🕒 Longer appointments are
needed to set up your plan
📅 You’ll check in with your GP
every 3–6 months
👉 Ask us today, or [Book Online
Now]

Keep it clear,
professional, and

actionable.

CALL TO 
ACTION

Do a PDSA - Reducing
Missed Appointments
for Care Plan reviews



Page 26  CCM Toolkit - © Gold Coast Primary Health Network
Printed copies of this document are uncontrolled. Version 2. 4 September 2025

2.3 Activity – How to check your MyMedicare registration

MyMedicare registration is voluntary. Patients are encouraged to register only with the practice they 
prefer to see for the management of their health, under the care of their chosen general practitioner.

The following steps can also be completed on the MyMedicare Express Plus App.

 93.3% received a visit 
Aug-Dec 2024

Primary Sense Training Requests &
Installations increased

Step 1

Step 2

Step 3

Step 4

Open and sign into
the myGov app on
your phone

MyMedicare registration is voluntary. Patients are encouraged to register only with the practice
they prefer to see for the management of their health, under the care of their chosen general
practitioner. 

The following steps can also be completed on the MyMedicare Express Plus app. 

HOW YOU CAN CHECK YOUR MYMEDICARE REGISTRATION

Select MyMedicare
registration history

Click View current
registration

Click Services on the
bottom right-hand
side of the screen

Select Medicare

Scroll down to
MyMedicare

To change your
MyMedicare
Registration to your
preferred General
Practice and
Practitioner, click
Register for
MyMedicare and
follow the prompts

Patients can only register at one practice. Care planning items including GPCCMP can only be completed by the MyMedicare registered practice.

 93.3% received a visit 
Aug-Dec 2024

Primary Sense Training Requests &
Installations increased

Step 1

Step 2

Step 3

Step 4

Open and sign into
the myGov app on
your phone

MyMedicare registration is voluntary. Patients are encouraged to register only with the practice
they prefer to see for the management of their health, under the care of their chosen general
practitioner. 

The following steps can also be completed on the MyMedicare Express Plus app. 

HOW YOU CAN CHECK YOUR MYMEDICARE REGISTRATION

Select MyMedicare
registration history

Click View current
registration

Click Services on the
bottom right-hand
side of the screen

Select Medicare

Scroll down to
MyMedicare

To change your
MyMedicare
Registration to your
preferred General
Practice and
Practitioner, click
Register for
MyMedicare and
follow the prompts

Patients can only register at one practice. Care planning items including GPCCMP can only be completed by the MyMedicare registered practice.

Scan the QR code
to sign in or 

create a MyGov 
account

https://www.servicesaustralia.gov.au/express-plus-medicare-mobile-app
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Activity Navigation 
3.1 Activity – MyMedicare patients
3.2 Activity – Patients not registered with MyMedicare
3.3 Activity – All CCM Patients due for a care plan and reviews
3.4 Activity – Patients with a chronic condition eligible for care plan or review

Module 3
Data-Driven Improvement

On completion of this module, you will:
•	 Use Primary Sense – Mastering MyMedicare to drive proactive care. All activities in this module use 

Primary Sense clinical searches and recipes to help identify, segment, and manage cohorts of patients 
for MyMedicare registration and chronic condition management.

•	 Apply data-driven strategies to plan, implement, and review quality improvement (QI) activities.

Before You Begin
•	 Ensure Primary Sense is installed on all desktops and all staff are trained on how to download and 

export reports. 
•	 Clean your data using Primary Sense Data Cleansing (e.g. archive inactive records, remove duplicates).
•	 Standardise coding: ensure diagnoses are coded, not free text – use Primary Sense condition mapping.
•	 Filter by doctor, condition, or age to create a smaller patient list.

Track & Reflect
•	 Download the audit worksheet or run chart template
•	 Record your baseline and follow-up data
•	 Reflect with your team: What worked? What didn’t?
•	 Completed QI documentation for CPD

RACGP 
Clinical Audit

Gold Coast offers a free, CPD-accredited Clinical Audit activity to 
help practices increase MyMedicare registration for patients with 

complex health needs. This supports proactive, data-informed care 
aligned with the 2025 CCM item changes.

READ 
NOW

https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/mymedicare/mymedicare-registration/
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3.1 Activity – MyMedicare patients

🎯Activity Goal: Identify patients who are MyMedicare registered at your practice.

Starting point
Log into HPOS → My programs → MyMedicare

Note: GCPHN does not provide software licensing for these systems.

Export Complete Registration List
1.	 Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’

2.	 Import patient list into your practice software
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3.2 Activity – Patients not registered with MyMedicare

🎯Activity Goal: Identify patients who may be eligible for Voluntary Patient Registration at a general 
practice, based on having had at least two face-to-face visits in the past two years or who are active based 
on RACGP definition of 3 visits in the past 2 years. Optionally, exclude patients without a Medicare card.

Starting point
Log into Primary Sense →  Reports →  load ‘Voluntary Patient Registration report’  →  Export to Excel

Complete a PDSA using the below templates

https://gcphn.org.au/wp-content/uploads/2025/02/NINCo_M5_MFI_Template.docx
https://gcphn.org.au/wp-content/uploads/2025/02/1732676943_NINCo_M5_MFI_Guidance.pdf
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3.3 Activity – All CCM Patients due for a care plan and reviews

🎯Activity Goal: Enhance care plan delivery for MyMedicare-enrolled patients managing chronic conditions.

Starting point
Log into Primary Sense →   Reports →  load ‘Patients with High Complexity 5 & 4 report’  →  Export to Excel

Start your PDSA
Download template.

 

 

 Developed by Prestantia Health for the PHN National Improvement Network Collaborative (NINCo) 

 

AIM 1. What are we trying to accomplish?  
By answering this question, you will develop your GOAL for improvement. It important to establish a S.M.A.R.T (Specific, Measurable, Achievable, Relevant, Time bound) and people-
crafted aim that clearly states what you are trying to achieve. 

Our Family Medical aims to increase the proportion of RACGP active patients with high complexity (level 5 & 4) who are registered for MyMedicare from 10% to 50% by the end of 
March 2025 
MEASURE(S) 2. How will we know that a change is an improvement?   
By answering this question, you will develop the MEASURE(S) you will use to track your overarching goal. Record and track your baseline measurement to allow for later comparison. 
Tip: Use a Run Chart to plot trends. 
 
Outcome Measure: % of active patients with high complexity (5 & 4) who are registered for MyMedicare 
Tool: Patients with High Complexity Level 5 & 4 Primary Sense report  
Frequency: Monthly 
Numerator: # of active patients with high complexity (level 5 & 4) registered in MyMedicare (A)  
Denominator: # of active patients with high complexity (level 5 & 4) (B) 
 
The proportion of active patients with high complexity (level 5 & 4) registered in MyMedicare (A divided by B) 
 

Baseline: 10% of active patients with high complexity (5&4) are registered in MyMedicare Baseline date: 03/02/2025 

CHANGE IDEAS 3. What changes can we make that will result in improvement? 
By answering this question, you will develop IDEAS for change.  
Tip: Engage the whole team in formulating change ideas using tools such as brainstorming, driver diagrams or process mapping. Include any predictions and measure their effect quickly.  

Idea 1 Identify active patients with high complexity (5 & 4) who are not registered in MyMedicare. 

Idea 2 Recall active patients with high complexity (5&4) who are not registered in MyMedicare and due for a care plan. 

Idea 3 Review the current CDM patient journey to identify how and when MyMedicare enrolment will be discussed. 

Idea 4 Provide MyMedicare registration training to receptionist, Nurse and GPs 
Next steps: Each idea may involve multiple short and small PDSA cycles. 

Step 1: Thinking Part - Three Fundamental Questions  
Complete the Model for Improvement (MFI) as a whole team. 

Please contact your
Engagement Officer for 

further support -
07 5612 540

practicesupport@gcphn.com.au

https://gcphn.org.au/practice-support/support-for-general-practice/quality-improvement/mymedicare/
https://gcphn.org.au/practice-support/support-for-general-practice/resources-for-general-practice/#practice-support-flyer
mailto:practicesupport@gcphn.com.au
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3.4 Activity – Patients with a chronic condition eligible for care plan or review

🎯Activity Goal: Enhance care plan delivery for MyMedicare-enrolled patients managing chronic conditions.

Starting point
Log into Primary Sense →   Reports →  load ‘Patients with Moderate Complexity 3’  →  Export to Excel

Start your PDSA
Download template.

 

 

 Developed by Prestantia Health for the PHN National Improvement Network Collaborative (NINCo) 

 

AIM 1. What are we trying to accomplish?  
By answering this question, you will develop your GOAL for improvement. It important to establish a S.M.A.R.T (Specific, Measurable, Achievable, Relevant, Time bound) and people-
crafted aim that clearly states what you are trying to achieve. 

Our Family Medical aims to increase the proportion of RACGP active patients with high complexity (level 5 & 4) who are registered for MyMedicare from 10% to 50% by the end of 
March 2025 
MEASURE(S) 2. How will we know that a change is an improvement?   
By answering this question, you will develop the MEASURE(S) you will use to track your overarching goal. Record and track your baseline measurement to allow for later comparison. 
Tip: Use a Run Chart to plot trends. 
 
Outcome Measure: % of active patients with high complexity (5 & 4) who are registered for MyMedicare 
Tool: Patients with High Complexity Level 5 & 4 Primary Sense report  
Frequency: Monthly 
Numerator: # of active patients with high complexity (level 5 & 4) registered in MyMedicare (A)  
Denominator: # of active patients with high complexity (level 5 & 4) (B) 
 
The proportion of active patients with high complexity (level 5 & 4) registered in MyMedicare (A divided by B) 
 

Baseline: 10% of active patients with high complexity (5&4) are registered in MyMedicare Baseline date: 03/02/2025 

CHANGE IDEAS 3. What changes can we make that will result in improvement? 
By answering this question, you will develop IDEAS for change.  
Tip: Engage the whole team in formulating change ideas using tools such as brainstorming, driver diagrams or process mapping. Include any predictions and measure their effect quickly.  

Idea 1 Identify active patients with high complexity (5 & 4) who are not registered in MyMedicare. 

Idea 2 Recall active patients with high complexity (5&4) who are not registered in MyMedicare and due for a care plan. 

Idea 3 Review the current CDM patient journey to identify how and when MyMedicare enrolment will be discussed. 

Idea 4 Provide MyMedicare registration training to receptionist, Nurse and GPs 
Next steps: Each idea may involve multiple short and small PDSA cycles. 

Step 1: Thinking Part - Three Fundamental Questions  
Complete the Model for Improvement (MFI) as a whole team. 

Please contact your
Engagement Officer for 

further support -
07 5612 540

practicesupport@gcphn.com.au

https://gcphn.org.au/wp-content/uploads/2025/04/PDSA-Identify-patients-with-high-complexity-level-5-4.pdf
https://gcphn.org.au/practice-support/support-for-general-practice/resources-for-general-practice/#practice-support-flyer
mailto:practicesupport@gcphn.com.au
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Activity Navigation 
4.1 Business Optimisation for CCM
4.2 CCM Claiming Annual Cycle of Care
4.3 Allied Health and Care Inclusions
4.4 Roles and Responsibility
4.5 Practice Workflow

Module 4
Team-based care approach

On completion of this module, you will:
•	 Optimise care plan reviews to boost efficiency, 

outcomes and practice performance.
•	 Allocate team tasks to ensure clarity and ownership of 

each member’s role.
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Revised structure for chronic disease management items

From 1 July 2025, there is a revised structure for items for chronic disease management. The changes 
simplify, streamline, and modernise the arrangements for health care professionals and patients. These 
changes primarily affect medical practitioners, however, allied health professionals providing MBS 
services should be aware of the changes to the plan and referral requirements. Transition arrangements 
will be in place for two years to ensure current patients don’t lose access to services.

Items for GP management plans (229, 721, 92024, 92055), team care arrangements (230, 723, 92025,  
2056) and reviews (233, 732, 92028, 92059) will cease and be replaced with a new streamlined GP chronic 
condition management plan (GPCCMP). Table below - Chronic Condition Management items commencing	
 1 July 2025.

Name of Item
GP item 
number

PMP item 
number

Frequency of 
Claiming

Fee

Prepare a GP chronic condition 
management plan – face to face

965 392 Every 12 months if 
clinically relevant

GPs - $156.55
PMPs - $125.30

Prepare a GP chronic condition
management plan - video

92029 92060 Every 12 months if 
clinically relevant

GPs - $156.55
PMPs - $125.30

Review a GP chronic condition
management plan – face to face

967 393 Every 3 months if 
clinically relevant

GPs - $156.55
PMPs - $125.30

Review a GP chronic condition
management plan – video

92030 92061 Every 3 months if 
clinically relevant

GPs - $156.55
PMPs - $125.30

The purpose of this resource is to support General Practices to plan their delivery of care for patients with 
chronic conditions and provide examples of how to use MBS items to provide regular care and review for 
patients in line with the intent of the MBS items.

This resource demonstrates the potential use of MBS items related to CCM, for a full explanation of each 
MBS item please go to MBS online. https://www.mbsonline.gov.au/

MBS ONLINE

•	 Search for Item Number
•	 Fact Sheets
•	 Updates (XML Files)
•	 MBS News

ELIGIBILITY

Ensure patient meets billing 
criteria.
•	 HPOS MBS checker
•	 My Health Record

MORE INFORMATION

•	 www.mbsonline.gov.au
•	 Contact MBS 13 21 50 

askMBS@health.gov.au

https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=965
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=392
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92029
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92060
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=967
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=393
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92030
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92061
https://www.mbsonline.gov.au/
https://www9.health.gov.au/mbs/search.cfm
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/factsheet-current
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/downloads
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/news
https://www.servicesaustralia.gov.au/check-mbs-item-numbers?context=20
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record
http://www.mbsonline.gov.au/
mailto:askMBS@health.gov.au
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4.1 Activity – Business Optimisation for CCM

The Chronic Conditions Management MBS changes support general practices to undertake proactive 
care planning, quarterly reviews, team-based follow-up and early intervention. General practices should 
consider, how best to support their chronic condition patients with self-management and care to improve
outcomes for their chronic conditions whilst effectively claiming to optimise practice Medicare revenue.

Approach
As a practice or as a team (GP, practice nurse, AHP, 
NP etc.), determine the approach you will take to 
GPCCMP and optimising both  atient outcomes and 
revenue.

•	 Annual GPCCMP: Developed and shared with 
the patient and care team.

•	 Quarterly Reviews: Assess goals, progress, 
symptoms, and update care as clinically 
required.

•	 Nurse/AHP Follow-up Services: Delivered up 
to 5 times annually to reinforce care plans and 
patient actions.

Nurses or AHP may provide support and follow 
up at the time of the management plan/ review 
appointment.

Alternatively, an approach may be for the nurse or 
AHP to provide a follow up phone call and support/
touch point with the patient to check in, confirm 
care plan goals, assist with allied health or any 
other referral pathways.

Either option the nurse or AHP can claim the MBS 
item 10997.

Revenue of one patient,
attending all review appointments

Why Review
•	 Use Care Planning Claiming workflow to 

explore care plan contents.
•	 Care plan reviews enable timely adjustments to 

medications, referrals, and self-management 
strategies.

•	 Ultimately, working in partnership with patients 
for better outcomes leads to reduced hospital 
admissions.

•	 Working together, with your team and patient to 
provide planned care across a 12-month cycle of 
care, will have an improved revenue impact.

Operational Tips
•	 Examine practice data - know who your CCM 

patients are.
•	 Determine a target - % of patients rebooked 

for review appointments (include missed 
appointments and DNAs)

•	 Engage your patients so they are well informed 
and aware of the reason/s for their review 
appointment and what will happen at the next 
appointment.

•	 Recall - utilise practice systems to automate 
appointment reminders and recalls.

•	 Flexibility - ensure your practice is able to 
provide patient’s access (flexibility may be key), 
face to face and/or telehealth may be required.

Refer MBS guide for the
frequently used items including Care
Planning and incentives This guide
links item number to MBS criteria,

descriptor and fact sheets

Service
Times/
Year

Annual amount
billed/ patient

Annual amount
billed/ patient

GPCCMP MBS
965 or 92029

1 $156.55

GPCCMP
Review MBS
967 or 92030

3 $469.65

Nurse/ AHP
follow up 10997 
or 93203

3-5 $42.00 -
$70.00

$667.15 -
$691.45

Bulk Billing Incentive & Bulk Billing Practice Incentive Program
To ensure your practice software applies the correct Bulk Billing Incentives, make sure MyMedicare status is updated regularly.

•	 From 1 November 2025, all Medicare-eligible patients will be eligible for bulk billing incentives.
•	 The CCM MBS items are eligible for Bulk Billing Incentive and Bulk Billing Practice Incentive Program items which attract 

additional payments.
•	 For more information on Bulk Billing Incentive changes click here

https://gcphn.org.au/wp-content/uploads/2025/11/GCPHN-MBS-Quick-Guide-1-November-2025-FINAL.pdf
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
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 –

☐ (≥6 months). No age restrictions
☐

☐

☐
☐

☐
☐ —
☐
☐

☐
☐
☐

☐

☐
☐
☐
☐

4.2 Activity – CCM Claiming Annual Cycle of Care

Refer to the Chronic Conditions Management MBS User Guide for examples of how CCM management planning items can be used and claimed by general 
practices.
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–

–

. Consider your patient’s unique wellbeing needs and lifestyle goals.

Other Management Plan Considerations 

 735, 739, 743, 747,     
750, 758

4.3 Activity – Allied Health Referrals and other GPCCMP considerations

There are a wide range of services and considerations that can enhance management plans. Consider your patient’s unique wellbeing needs and 
lifestyle goals. Refer to HealthPathways for evidence based clinical decision support to inform management planning for each chronic condition. 
More info, visit HealthPathways

MBS 735, 739, 743, 747,
750, 758

https://goldcoast.communityhealthpathways.org/
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&qt=NoteID&q=AN.15.6
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&q=MN.9.1&qt=noteID&criteria=mn.9.1
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=735
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=739&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=743&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=747&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=750&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=758&qt=ItemID
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4.4 Activity – Roles and Responsibility (Swim Lane workflow)

Use this swim lane process map to visually clarify team members roles and responsibilities and who performs each task in the care 
process, identify inefficiencies, and collaboratively redesign workflows to ensure everyone works at the top of their scope. 
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4.5 Activity - Sample workflows

–

Primary Sense data extraction

MyGov App.
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Navigation 
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5.8 Useful contacts 
5.9 MBS Quick Guide

Appendices
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5.1 Quality Improvement documentation

Start by documenting your practice QI team and define your problem and specified a robust 
Problem Statement.

Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA

–

and PDSA’s.

 

 

 

practicesupport@gcphn.com.au

https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://www.ihi.org/resources/how-improve-model-improvement
https://www.ihi.org/resources/tools/run-chart-tool
https://www.ihi.org/library/tools/quality-improvement-essentials-toolkit
https://www.ihi.org/resources/tools/driver-diagram
https://www.ihi.org/resources/tools/flowchart
https://gcphn.org.au/wp-content/uploads/2025/02/1732676943_NINCo_M5_MFI_Guidance.pdf
https://gcphn.org.au/wp-content/uploads/2025/02/NINCo_M5_MFI_Template.docx
mailto:practicesupport%40gcphn.com.au?subject=
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–

–

 

(CCM) changes, while defining and documenting each team member’s roles and responsibilities. This will help build readiness 

 

• 
• 
• 
• 

 

• –

• 

• 

• 

• 

with the practice’s current 

• 

• 

• 

• 

member’s role in CCM and MyMedicare.:
• 
• 

• 

–

• 

• 

• 

• 

• 

• 

5.2 PDSA – Team awareness, desire and readiness
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–

–

 

 

 

• 

• 

5.3 PDSA – Identifying Active Patients and Linking to MyMedicare 	  	
       Program
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–

–

 

 

 

from MyMedicare registration. 
Practice Manager to ensure all 
staff are trained and equipped 
with key messages for patient 
conversations. Prediction: 
Flagging and staff messaging will 
increase MyMedicare 
registrations.

exercise using Primary Sense to
identify patients with diagnosed
or potentially undiagnosed
chronic conditions. Prediction:

Train clinical staff on accurate
coding procedures using Primary
Sense, Best Practice, and Medical
Director tools. Prediction:
improved management plan
eligibility identification.
Prediction: Training will improve
coding accuracy and
management plan eligibility.

Use data tools (e.g. Primary Sense) to identify patients with chronic conditions who are not yet registered with
MyMedicare.

Use Primary Sense to identify
MyMedicare-registered patients
due for a GPMP/TCA. Aim to
optimise both management
planning and MBS claiming.
Prediction: Recalls will boost
attendance

Standardise coding
practices within the
PMS. Use Primary
Sense condition
Data Mapping

5.4 PDSA – CCM and MyMedicare

https://help.pencs.com.au/display/CG/Data+Cleansing
https://help.pencs.com.au/display/ds/Indicated+Diagnoses+Report
https://help.pencs.com.au/display/ds/Indicated+Diagnoses+Report
https://help.pencs.com.au/display/ADM/Data+Mapping
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–

–

 

 
 
 
 
 

 

Develop a structured follow-up 

to identify and act on missed 
chronic condition reviews. 
Create standard letter and call 
templates. Prediction:
A consistent follow-up process 
will reduce missed appointments 
by at least 20% within 6 weeks.

–

Incorporate
personalised goals into
all care plan templates.
Use Primary Sense
reports to monitor
patient progress
monthly.�

5.5 PDSA – Reducing Missed Appointments for Management plan 	     	
       reviews
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5.6 Measuring Outcomes – Audit Worksheet

1.	 Choose the QI activity measure that aligns with your practice goal
2.	 Enter a practice target and baseline for each QI activity measure in the table below
3.	 Track your progress over time by entering a result for reporting period.
4.	 Use run chart to plot results over time.

Measure:
Practice
Target

Baseline
date

Result 1
date

Result 2
date

Result 3
date

Result 4
date

Example PIPQI # (%) % # (%) # (%) # (%)
# (%)

MyMedicare registered 
patients

MyMedicare registered 
and CCM patients

Patients due for CCM or 
review

Patients with ‘Diabetes’

Patients with a billed 
Care Plan in the past 12 
months

Insert QI activity measure

Insert QI activity measure

Insert QI activity measure

* Per RACGP, an active patient has 3+ visits in 2 years. This filter may exclude new or at-risk patients who don’t see their GP regularly
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5.7 Group reflection – after completing activities

As a team, analysis and review baseline data results and discuss change ideas and actions. 
Use PDSA cycles to test and measure change ideas

The degree to which the learning needs were met:
       Not met
       Partially met
       Entirely met

To what degree this activity was relevant to your
practice:
       Not met
       Partially met
       Entirely met

What did you learn? What changes would you make to your practise as a result?

For example,
•	 Has patient engagement increased through education efforts?
•	 Which educational strategies were most effective?
•	 Have MyMedicare registrations improved following engagement efforts?
•	 Do relevant team members know how to send out GoShare patient resources, videos and apps?
•	 What barriers were encountered in patient engagement?

RACGP CPD: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection.

https://mycpd.racgp.org.au/log
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5.8 Useful contacts

Gold Coast PHN 07 5612 5408 | practicesupport@gcphn.com.au
www.gcphn.org.au
Engagement Officer flyer

Provider Digital Access (PRODA) PRODA 1800 700 199 (option 1) | proda@servicesaustralia.gov.au

PRODA Information

Training: PRODA eLearning

Health Professional Online Services 

(HPOS)

132 150 (option 6)

HPOS Access

Training: HPOS eLearning

Medicare Provider Enquiries (Medicare 

Programs)

Phone: 132 150 (Option 2 - Claiming, payment, Provider Registration,

MyMedicare and Organisation Register enquiries)

Services Australia Incentive Program 1800 222 032

Incentive Program Information

Training: Incentive Programs eLearning

MBS 13 21 50 | askmbs@health.gov.au
MBS online

Training: MBS Training eLearning

Healthdirect 1800 580 771 | videocallsupport@healthdirect.org.au

Registration Form Video Call
Video Call

Australian Immunisation Register 1300 650 039
air@humanservices.gov.au

Department of Veteran Affairs 1800 550 457

Services Australia eBusiness 1800 700 199
ebusiness@humanservices.gov.au

Primary Sense 07 5612 5476 | primarysense@gcphn.com.au
www.primarysense.org.au

Medical Director 1300 300 161
www.medicaldirector.com

Best Practice 1300 40 1111 | support@bpsoftware.net
www.bpsoftware.net

Translating and Interpreting Service 

(TIS National)

131 450

My Aged Care 1800 200 422

MyGov help desk 132 307 - option 1

eRx 1300 700 921

Healthlink 1800 125 036

My Health Record 1800 723 471

Gold Coast Hospital and Health Service – 

GP Advice Line

1300‑004‑242 (option 3) | GCGPLU@health.qld.gov.au

 – please ensure you de‑identify patient information if sending by email. Only provide the 

initials of your patient’s name and date of birth. Available Monday to Friday, 8am to 4pm.

Gold Coast Public Health Unit (07) 5667‑3200 | GCPHU@health.qld.gov.au (do not include any patient information)

For after hours health advice, phone 13 HEALTH (13 43 25 84)

Medicare Urgent Care Clinic Southport 07 5680 0040 | Oxenford 07 5573 1122
www.gcphn.org.au/medicare-urgent-care-clinic

mailto:practicesupport@gcphn.com.au
https://www.gcphn.org.au
https://gcphn.org.au/practice-support/support-for-general-practice/resources-for-general-practice/#practice-support-flyer
mailto:proda@servicesaustralia.gov.au
https://www.servicesaustralia.gov.au/proda-provider-digital-access
https://hpe.servicesaustralia.gov.au/provider-digital-access.html
https://www.servicesaustralia.gov.au/hpos?context=20
https://hpe.servicesaustralia.gov.au/eLearning_HPOS.html
https://hpe.servicesaustralia.gov.au/incentive-programs.html
https://www.health.gov.au/our-work/increases-to-bulk-billing-incentive-payments
mailto:askmbs@health.gov.au
https://www9.health.gov.au/mbs/search.cfm
https://hpe.servicesaustralia.gov.au/eLearning_MBS.html
mailto:videocallsupport@healthdirect.org.au
https://www.healthdirect.gov.au/video-call-reg
https://help.vcc.healthdirect.org.au/95525-getting-set-up-with-video-call-for-the-first-time/webinars
mailto:air@humanservices.gov.au
mailto:ebusiness@humanservices.gov.au
mailto:primarysense%40gcphn.com.au?subject=
http://www.primarysense.org.au
http://www.medicaldirector.com/
mailto:support@bpsoftware.net
http://www.bpsoftware.net/
mailto:GCGPLU@health.qld.gov.au
mailto:GCPHU@health.qld.gov.au
https://gcphn.org.au/medicare-urgent-care-clinic/#when-to-visit-the-medicare-urgent-care-clinics
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5.9 MBS Quick Guide

This guide outlines the frequently used Medicare Benefits Schedule (MBS) items with each item number 
linked MBS criteria, descriptor and fact sheets. Click here for a full list of MBS items.

MBS ONLINE
•	 Search for Item Number
•	 Fact Sheets
•	 Updates (XML Files)
•	 MBS News

ELIGIBILITY
Ensure patient meets billing 
criteria.
•	 HPOS MBS checker
•	 My Health Record

MORE INFORMATION
•	 www.mbsonline.gov.au
•	 Contact MBS 13 21 50 

askMBS@health.gov.au
•	 Gold Coast HealthPathways 

- MBS Items

CHRONIC CONDITIONS MANAGEMENT (CCM) Face to Face Telehealth*

GP chronic condition management plan** (EVERY 12 MONTHS if clinically 
relevant)

965† 92029†

GP chronic condition management plan Review** (EVERY 3 MONTHS if clinically 
relevant)

967† 92030†

Practice Nurse /Aboriginal Health Practitioner follow-up services for a patient
with a chronic condition (5 PER YEAR)

10997 Phone 93203
Video 93201

Practice Nurse/Aboriginal Health Practitioner follow-up services for Aboriginal
and Torres Strait Islander patients (10 PER YEAR)

10987 Phone 93202
Video 93200

Domiciliary Medication Management Review (DMMR) (ANNUALLY) 900

GP contribution to multidisciplinary plan – Community (EVERY 3 MONTHS) 729 92026

GP contribution to multidisciplinary plan (MCP) – RACF (EVERY 3 MONTHS) 731 92027

Residential Medication Management Review (RMMR) (ANNUALLY) 903

† MyMedicare registered patients can only access these services at their MyMedicare 
general practice
*Telehealth (Video Consults) and *Telephone (Phone Consults) available to Medicare-
eligible patients with an established practice relationship who have attended in-person 
within the past year can access services.
(Exceptions include children under 12 months, COVID-19 isolation, natural disaster areas, 
Aboriginal Medical Services, urgent after-hours care, homelessness, or services for blood-
borne viruses, sexual/reproductive health, or TOPIC. The 30/20 rule applies to telephone 
items.)
**Patients with a General Practitioner Chronic Disease Management Plan/Review can access 
the following MBS services:
•	 Allied Health Services: Up to 5 individual sessions per year (10 for Aboriginal or Torres 

Strait Islander patients).
•	 Nurse or Health Practitioner Services: Up to 5 services annually, provided on behalf of a 

doctor.
•	 Type 2 Diabetes Care: If eligible, up to 8 yearly group sessions for dietetics, education, or 

exercise.

https://gcphn.org.au/wp-content/uploads/2025/11/GCPHN-MBS-Quick-Guide-1-November-2025-FINAL.pdf
https://www9.health.gov.au/mbs/search.cfm
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/factsheet-current
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/downloads
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/news
https://www.servicesaustralia.gov.au/check-mbs-item-numbers?context=20
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record
http://www.mbsonline.gov.au/
mailto:askMBS@health.gov.au
https://goldcoast.communityhealthpathways.org/13454.htm
https://goldcoast.communityhealthpathways.org/13454.htm
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=10997&qt=item&criteria=10997
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93203&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93201&qt=item&criteria=93201
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=10987
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93202&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93200&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=900
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=729&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=92026
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=731&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=92027
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=903&qt=ItemID
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Telehealth-Updates-April%202023
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Telehealth-Updates-April%202023
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CASE CONFERENCING

Case Conference GP organises (MAX. 5 TIMES PER PATIENT PER CALENDAR YEAR) 735 739 743

Case Conference GP participating (MAX. 5 TIMES PER PATIENT PER CALENDAR YEAR) 747 750 758

BULK BILLING INCENTIVES (BBI)

BBI (MBS MN.1.1) can be claimed when you bulk bill a child under 16 or a Commonwealth Concession Card holder. 
Expanding eligibility for Medicare bulk billing incentives takes effect 1 Nov, 2025.

MyMedicare enrolled patients only at their enrolled practice
•	 Level C, D, E (Telehealth*)
•	 Level C, D (Telephone*)

75880†

•	 Level B, C, D, E (Face to Face)
•	 Level B (Telehealth*, Telephone*)

75870

All other eligible services not covered below (refer MBS MN.1.1) 10990

To ensure your practice software applies the correct Bulk Billing
Incentives, make sure MyMedicare status is updated regularly.

http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=735
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=739&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=743&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=747&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=750&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=758&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&qt=NoteID&q=MN.1.1
https://www.servicesaustralia.gov.au/concession-and-health-care-cards
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
https://www.health.gov.au/our-work/mymedicare
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=75880
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=75870&qt=item&criteria=75870
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&qt=NoteID&q=MN.1.1
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=10990
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
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